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INTRODUCTION 

What is 2X ApplicationServer and How Does it Work? 

 

2X ApplicationServer is an application that provides vendor independent 
virtual desktops and applications. Accessible from anywhere. 2X 
ApplicationServer allows you to publish full desktops and applications within 
a virtual environment, improving desktop manageability, security and 
performance.  

 

2X ApplicationServer extends Windows Terminal Services by using a 
customized shell and virtual channel applications using the Microsoft RDP 
protocol.  

 

2X ApplicationServer supports a number of different technologies, including 
Microsoft Terminal Server , VMware, Oracle VirtualBox, Microsoft Virtual 
Server, Microsoft Hyper-V, Virtual Iron, and Parallels, to allow the publishing 
of virtual applications and desktops to the 2X Client. Virtual objects are load 
balanced over all available machines while automatically releasing unused 
resources. 

 

How Does it Work? 

 

When a client requests a virtual desktop, the system finds a guest on one of 
the least loaded hosts and starts or restores the guest connection.  Using 
Microsoft RDP protocol, the virtual desktop is presented to the user.   

 

Thin client computing is solving the growing management problem of fat 
clients (PCôs), allowing employees to roam easily and seamlessly, improving 
performance.  Companies that have migrated to a thin client environment 
consistently see huge savings on support, hardware and upgrade costs. In a 
world where energy use is an increasing concern, implementing a thin client 
environment improves energy costs as well.  A study conducted by Bloor 
Research shows that "Deploying thin client technology across enterprises 
can cut costs by up to 70%". 
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2X ApplicationServer System Requirements 

 

2X Publishing Agent and 2X SecureClientGateway are preferably installed on 
the following operating systems: Windows 2008/R2Server/Enterprise Server; 
Windows 2003 Server/Enterprise Server; Windows 2000 Server/Advanced. 

 

2X Terminal Server Agent must be installed on Windows 
2008/R2Server/Enterprise Server with Terminal Services enabled; Windows 
2003 Server/Enterprise Server with Terminal Services enabled; Windows 
2000 Server/Advanced Server with Terminal Services enabled. 

 

2X Client is approved for the following operating systems: Windows 2000, 
Windows 2003, Windows XP, Windows Vista, Windows 7, Windows CE, 
Windows Embedded, Mac 10.5.x and above. 2X Client is now available for 
iOS (iPhone and iPad) and for Android. 

 

The 2X Client is also approved for the following 32-bit Linux distributions: 
Ubuntu 8.04, Ubuntu 8.10, Ubuntu 9.04, Ubuntu 9.10, OpenSuse 11.1, 
Fedora Core 9, Fedora Core 11, CentOs 5.2, VectorLinux 6.0. 

 

NOTE: The 30-day trial version and the full version of the application have 
the same features. After the 30-day trial period has expired, the only action 
necessary will be to enter a valid license key on the Licensing page. Re-
installation will not be necessary. Please refer to the óLicensingô chapter in 
this manual for more information. 
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INSTALLING 2X APPLICATIONSERVER  

Before you run the installation procedure please make sure that you are logged on 
with administrator rights and that the system requirements are met. 
 
Make sure all other Window programs are closed. 
 
The ó2XAppServer.msiô file can be found on our website, www.2X.com, available as 
a free download.  Run the 2X ApplicationServer setup program on the machine to be 
used as your access point to your terminal servers and/or virtual hosts.  
 
Choose what to install according to your needs and requirements. Two common 
scenarios are the óregular gateway scenarioô and the ódirect mode scenarioô. 
For more advanced and alternative scenarios and solutions please read 2X Server 
Based Computing Guide. 
 
 
 
Double click on the 2XAppServer.msi file and a welcome dialog box will appear. 
 
Click óNextô. 
 

  
2X ApplicationServer  Setup Program welcome screen. 

Accept the license agreement by checking the óI accept the terms in the License 
Agreementô checkbox.  

 

http://www.2x.com/
http://www.2x.com/solutions/2XSolutionsguide.pdf
http://www.2x.com/solutions/2XSolutionsguide.pdf
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The License Agreement. 

 

Accept the default location or Browse to where you want to install 2X 
ApplicationServer and click óNextô. 

 

  
 Choosing the location where 2X ApplicationServer will be installed. 

Select 2X ApplicationServer XG  for complete product installation. 
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Choose Your Installation type Setup Wizard installs 2X ApplicationServer  

 

Click install to continue with the installation of 2X ApplicationServer. 

 

 

  

 

Click on Finish to launch the Configuration Utility.  If the utility does not automatically 
open, go to Start>2X Application Server Console to launch the utility. 
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Setup Completed  
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2X ApplicationServer Services 

 

To start, stop and configure 2X ApplicationServer Services, run the Microsoft Management Console 
óServices.mscô. 2X ApplicationServer  services are configured to start automatically when the system 
starts. The services installed depend on the installation you selected. 

 

 
 

 2X Secure Client Gateway, 2X Publishing Agent, 2X Redundancy Service and 2X Terminal 
Server Agent, 2X VDI Agent 

 

2X Publishing Agent - provides load balanced applications and desktop 
publishing. 

2X Redundancy Service - provides redundancy to 2X ApplicationServer  

2X SecureClientGateway - tunnels all traffic needed by 2X applications on a 
single port and provides secure connections. 

2X TerminalServer Agent ï provides terminal server information to 2X 
Publishing Agent 

2X VDI Agent ï provides VDI host information to the 2X Publishing Agent 

 

NOTE: All users who are connected via the 2X Secure Client Gateway will be 
disconnected if the 2X Secure Client Gateway service is stopped or restarted. 
Note that the default port (80) may already be in use (for example, by an 
HTTP server) ï in this case it will be necessary to use a port number not 
currently in use by other local services.  
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Pre- Configuration MS Terminal Server Settings 

 

With Terminal Services Configuration, you can reconfigure the properties of the RDP-TCP 
connection, including limiting the amount of time client sessions can remain active on the 
server, setting protection levels for encryption, and selecting which permissions you want 
users and groups to have.  
 
Terminal Services Group Policies or Terminal Services extension to Local Users and Groups 
are the settings that you use to set connection properties on a per-user basis. You can set 
different session time limits for each user when you use the Terminal Services extension to 
Local Users and Groups. 
 
Use Terminal Services Configuration to set the same time limit to all users who log on using 
the same server connection. 

 

 
 Configuring Terminal Services Connections 

 

From the Start menu > Administrative Tools>Terminal Services Configuration 

 

Server Settings 

 

Click on Server Settings and click the óRestrict each user to one session optionô.  This enables 
reconnections to previously disconnected user sessions, conserving server resources. 

 

NOTE: This feature is also configurable in the óLoad Balancingô section. 
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Connection Settings 

 

Select óConnectionsô and double-click the óRDP-TCPô connection. This will open the RDPTCP 
Properties dialog box.   

 

Logon Settings Tab 

 

 
Logon Settings 

 

Verify that the óAlways prompt for passwordô checkbox is unchecked; allowing clients 
to launch applications using the credentials that have been saved on the 2X Client.  
This will avoid unnecessary repeated authentication cycles. 
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Environment Tab 

 

 

 
 Environment 

 

On the óEnvironmentô tab make sure that the option óRun initial program 
specified by user profile and Remote Desktop Connection or Terminal 
Services clientô is ENABLED.  Click Ok. 
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CONFIGURING 2X APPLICATIONSERVER  

Introduction to the Configuration of ApplicationServer  

 

After you have installed 2X ApplicationServer you can now launch the 2X ApplicationServer 
Console for additional configuration. 

 

 
 Launching the 2X ApplicationServer Console 

 
To open the 2X ApplicationServer Console go to:  
 
Start > [All] Programs > 2X > ApplicationServer  > 2X ApplicationServer 
Console 
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2X ApplicationServer Console Environment & Components 

 

The 2X ApplicationServer Console is a completely self-contained environment that is used to 
enable Universal Printing and Scanning, publish seamless applications, also providing load 
balancing to published desktop sessions and Virtual Desktop Hosts, Terminal Server and/or 
Citrix sessions. Below is a brief description of each component located in the Navigation Bar. 

 

Components of the Navigation Bar  

 

¶¶  Farm 

Add Virtual Desktop Hosts, Microsoft Terminal Servers and Citrix Servers 
to the farm. 

¶¶  Load Balancing 

Choose the load balancing method to be used. 

¶¶  Publishing 

Publish applications, application groups, virtual desktops and desktops. 

¶¶  Universal Printing 

Enable Universal Printing to each Terminal Server. 

¶¶  Universal Scanning 

Enable Universal Scanning to each Terminal Server. 

¶¶  Connection Settings 

Configure which port to use for each service. 

¶¶  Client Settings  

Configure and enable client settings. 

¶¶  Information 

Find information about the modules used, enable logging, and enable 
notification. 

¶¶  Licensing 

Obtain or review your licensing information and license number for 2X 
ApplicationServer  products. 
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Console Environment 

 

 
Console Environment/Publishing 

 

11..  The Navigation Bar enables you to navigate through the main 
features offered by 2X ApplicationServer Console. You can also 
change which features are displayed using the View Menu. 

22..  The Published Applications Explorer panel is a navigational 
tree which represents the organization of your published 
applications, application groups and desktops. 

33..  The Published Applications Properties panel contains up to 
four additional tabs that will display Information, Publish From, 
Application and Filtering options for each published application. 

44..  The Publishing Tools allow you to Add, Delete, and Disable, 
Sort and Find for selected published applications. You can also 
move your published applications using the Move Up or Move 
Down tools. The publishing tools also provide you with the ability 
to publish your applications to the web. 

55..  The Toolbar consists of a set of tools grouped together that 
provides quick and convenient access to commonly performed 
operations. 
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Console Environment ï Basic Layout 

 

 
Console Environment ï Basic Layout 

 

1. The Navigation Bar enables you to navigate through the main 
features offered by the 2X Console. You can also select which main 
feature to be displayed from the View Menu.  

2. The Properties Pane is the main area from where you can edit and 
modify each configuration. 

3. The Information Pane gives a quick look and summary about the 
particular selected page. 

4. The Toolbar consists of a set of tools grouped together to provide 
quick and convenient access to commonly-performed operations. 

 

 




























































































































































































































































































































































































































